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12 tips for better e-mail etiquette 
  
By Laura Stack, MBA, CSP, The Productivity Pro® 

I remember opening my first e-mail account and thinking how much fun it was to send a message to a friend. However, 
most people now no longer find e-mail simple or fun. E-mail messaging now exceeds telephone traffic and is the 
dominant form of business communication. Some workers tell me that handling e-mail consumes half of their day. A 
recent Wall Street Journal report indicates that soon employees will spend three to four hours a day on e-mail. 
Don't you wish that every person who received a new e-mail account had to agree to follow certain rules to use it? There 
are certain professional standards expected for e-mail use. Here are some things to keep in mind regarding professional e-
mail conduct: 
 

1. Be informal, not sloppy. Your colleagues may use commonly accepted abbreviations in e-mail, but when 
communicating with external customers, everyone should follow standard writing protocol. Your e-mail message 
reflects you and your company, so traditional spelling, grammar, and punctuation rules apply.  
 

2. Keep messages brief and to the point. Just because your writing is grammatically correct does not mean that it has 
to be long. Nothing is more frustrating than wading through an e-mail message that is twice as long as necessary. 
Concentrate on one subject per message whenever possible.  
 

3. Use sentence case. USING ALL CAPITAL LETTERS LOOKS AS IF YOU'RE SHOUTING. Using all lowercase letters looks 
lazy. For emphasis, use asterisks or bold formatting to emphasize important words. Do not, however, use a lot of 
colors or graphics embedded in your message, because not everyone uses an e-mail program that can display them.  
 

4. Use the blind copy and courtesy copy appropriately. Don't use BCC to keep others from seeing who you copied; it 
shows confidence when you directly CC anyone receiving a copy. Do use BCC, however, when sending to a large 
distribution list, so recipients won't have to see a huge list of names. Be cautious with your use of CC; overuse 
simply clutters inboxes. Copy only people who are directly involved.  

 
5. Don't use e-mail as an excuse to avoid personal contact. Don't forget the value of face-to-face or even voice-to-

voice communication. E-mail communication isn't appropriate when sending confusing or emotional messages. 
Think of the times you've heard someone in the office indignantly say, "Well, I sent you e-mail." If you have a 
problem with someone, speak with that person directly. Don't use e-mail to avoid an uncomfortable situation or to 
cover up a mistake.  

 
6. Remember that e-mail isn't private. I've seen people fired for using e-mail inappropriately. E-mail is considered 

company property and can be retrieved, examined, and used in a court of law. Unless you are using an encryption 
device (hardware or software), you should assume that e-mail over the Internet is not secure. Never put in an e-
mail message anything that you wouldn't put on a postcard. Remember that e-mail can be forwarded, so 
unintended audiences may see what you've written. You might also inadvertently send something to the wrong 
party, so always keep the content professional to avoid embarrassment.  

 
7. Be sparing with group e-mail. Send group e-mail only when it's useful to every recipient. Use the "reply all" button 

only when compiling results requiring collective input and only if you have something to add. Recipients get quite 
annoyed to open an e-mail that says only "Me too!"  

 
8. Use the subject field to indicate content and purpose. Don't just say, "Hi!" or "From Laura." Agree on acronyms to 

use that quickly identify actions. For example, your team could use <AR> to mean "Action Required" or <MSR> for 
the Monthly Status Report. It's also a good practice to include the word "Long" in the subject field, if necessary, so 
that the recipient knows that the message will take time to read.  
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9. Don't send chain letters, virus warnings, or junk mail. Always check a reputable antivirus Web site or your IT 
department before sending out an alarm. If a constant stream of jokes from a friend annoys you, be honest and ask 
to be removed from the list. Direct personal e-mail to your home e-mail account.  

 
10. Remember that your tone can't be heard in e-mail. Have you ever attempted sarcasm in an e-mail, and the 

recipient took it the wrong way? E-mail communication can't convey the nuances of verbal communication. In an 
attempt to infer tone of voice, some people use emoticons, but use them sparingly so that you don't appear 
unprofessional. Also, don't assume that using a smiley will diffuse a difficult message.  

 
11. Use a signature that includes contact information. To ensure that people know who you are, include a signature 

that has your contact information, including your mailing address, Web site, and phone numbers.  
 

12. Summarize long discussions. Scrolling through pages of replies to understand a discussion is annoying. Instead of 
continuing to forward a message string, take a minute to summarize it for your reader. You could even highlight or 
quote the relevant passage, then include your response. Some words of caution:  

 If you are forwarding or reposting a message you've received, do not change the wording.  

 If you want to repost to a group a message that you received individually, ask the author for permission 
first.  

 Give proper attribution.  
 
Use these suggestions as a starting point to create e-mail etiquette rules that will help your team stay efficient and 
professional. 
 
About the author   Laura Stack is the president of The Productivity Pro®, Inc., an international consulting firm in Denver, 
Colorado, that specializes in productivity improvement in high-stress organizations. Laura holds an MBA in Organizational 
Management (University of Colorado, 1991) and is an expert on integrating advances in business productivity with the 
retention of key employees. Laura is the author of the best-selling book Leave the Office Earlier (Broadway Books, 2004). 

 
 

Managing your email 

When you read a message in e-mail, that message often causes you to take some sort of action. Your action 
might be to respond right away with a reply, or to take some secondary action, such as setting up a meeting. 

In order to clear away the clutter in your Inbox, think about a message as you read it and decide whether it 
requires action. If action is required, think about what you need to do. Should you respond right now? Later? 
Do you need to flag the message for follow-up, or create a task? Use Outlook to take action when and how you 
need to. 

Even if an e-mail message doesn't require a direct response, the information in the message may still cause 
you to:  

 Store contact information  

 Create a task  

 Set up a meeting  

You can get started with each action by simply dragging the message to the appropriate button on the 
Navigation Pane. While this functionality isn't new to Outlook 2007, it's a handy way to see how messages in 
Outlook can have uses beyond e-mail. 

Note that dragging creates a new item, and doesn't get the message out of your Inbox. It's up to you to delete 
it if you don't need it anymore. 

http://office.microsoft.com/search/redir.aspx?AssetID=HA011924231033&CTT=5&Origin=HA012054101033
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If a message makes you realize that you need to meet with someone, here's a quick way to get started:  

  Drag the message to the Navigation Pane. 

 A new appointment opens, where you'll fill in 
the rest of the details (such as the date, time, 
and location).  

 Then, you'll invite the person to the meeting, 
and click  Send. 

Sometimes a message contains information about 
some action that you need to take. For example, in 
the picture, the message from Ben Smith in Mark 
Lee's Inbox reminds Mark that he needs to promote 
a line of office furniture that his company recently 
introduced. 

Mark can drag the message from his Inbox to the Tasks button in the Navigation Pane to quickly start a new 
task. He can change the subject to something more task-like, for example Show office furniture to Coho, and 
then save the task. The task is added to Mark's task list. 

If you're keeping a message around so 
that you'll have a contact's e-mail address 
handy, we have a better idea. Why not 
create a contact entry in Contacts? 

As we've shown in the picture, you can 
drag a message to Contacts to get the 
contact entry started. When you drag a 
message to the Contacts button, a new 
Contact form opens and the e-mail 
address in the message is automatically 
added to it. 

From there you can fill in the rest of the details, such as a street address, telephone number, and so on. The 
next time you need to look up a bit of information about that contact, you'll know right where to look: in 
Contacts. 

By storing contact information in Contacts you'll be able to easily search for the contact, add him or her to a 
distribution list, or use the person's contact information in a mail merge. You can even store a contact's picture 
with the contact so you can always see a face with the name. And new to Outlook 2007 are Electronic Business 
Cards, which you can use to quickly and easily share contact information. 
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The To Do Bar 

The first time you start Outlook 2007, you'll notice something new. It's called the To-Do Bar, and it's there to 
help you keep track of what you need to do. 

In the To-Do Bar, you'll see upcoming items from your calendar as well as flagged messages and tasks. Curious 
about how things get into the To-Do Bar? That's what this lesson will tell you. 

The To-Do Bar displays flagged 
messages (which we'll talk more 
about shortly), tasks from your Tasks 
folder, and upcoming meetings, 
appointments, and events from your 
calendar. In the To-Do Bar, you can 
see these things at a glance, without 
having to switch to other windows in 
Outlook. We've shown the basic 
parts of the To-Do Bar in the picture 

 Date Navigator 
 Upcoming calendar appointments 
 A place to enter new tasks by typing 
 Your task list (flagged messages and tasks) 

 

Prioritize with follow up flags 

If you read the first lesson, you're familiar with the method of dragging a message to the Tasks button in the 
Navigation Pane to create a task from a message. The task helps you keep track of what you need to do, based 
on the information in the message, but it's separate from the original message. 

An even easier way to keep track of what you need to do, based on the information in a message, is to simply 
flag the message for follow-up. When you flag a message, you'll remember to attend to it — even if the 
message starts to sink to the bottom of your Inbox. 

In the picture, we've shown a message in the Inbox that has been flagged with a follow-up flag. Notice that the 
flagged message also appears in the To-Do Bar. 

Tip   Another quick way to attach a flag 
to a message is to drag the message 
directly to the To-Do Bar. 

Flagged messages show up in many 
places 

Messages that you flag for follow-up 
not only show up in the To-Do Bar, 
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they also show up in your task list and on your calendar. That's to help you remember to do the things on your 
list. And, if that's not enough, you can set reminders for them so that you actually remember to follow up. 

Change the subject, but only in the To-Do Bar 

Because the subject of a message doesn't always describe the task that you need to do, you'll be glad to know 
that you can change the subject of a flagged message in the To-Do Bar. When you do this, the subject of the 
message in the Inbox is unchanged. 

So, you may wonder: What's the difference between a flagged message and a task created by dragging to the 
Tasks button? The answer is that it's mostly a matter of style. 

 If you like to delete messages after you've finished with them, you'll probably prefer to use Tasks to 
keep track of things you need to 
do. (When you drag a message to 
the Tasks button, you create a new 
item, so deleting the message 
doesn't affect the task.)  

 If you like to keep your messages 
(either in your Inbox or in 
folders — which we'll talk about in 
a later lesson), you'll probably 
prefer to use follow-up flags 
because flagging is quick and easy.  

When you complete, don't delete 

You may be tempted to delete items from the To-Do Bar when you've completed them. However, there's a 
better way. When you complete a task, mark it as complete using the Mark Complete command. (A quick way 
to do this is to simply click the flag next to the item.) Completed items will drop off of your list as you might 
expect. 

But what's really helpful about marking an item as complete is that you'll see it listed on your calendar at the 
bottom of the day on which you completed it. And it'll be crossed out so that you'll know you've completed it. 

It's a great way to remind yourself of all of the work that you've done. 

In the To-Do Bar and in the Calendar, any task not marked as 
complete on its due date will automatically be carried over to the 
following day until you complete it. 

 Caution    If you choose to delete an item from the To-Do Bar, the 

flagged message will also be deleted from your Inbox. Similarly, if you 
delete the flagged message from the Inbox, you'll also delete it from 
the To-Do Bar. Mark Complete is safer 
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Show the To-Do Bar as you like it 

To change what's shown in the To-Do Bar, click To-Do Bar on the View menu, and select or clear the items you 
want to show or hide. (Or, click Options to customize all To-Do Bar options at once.) 

Showing and hiding the To-Do Bar is easy: 

 To hide it, simply press ALT+F2 or click the Close button. 

 Show it again by pressing ALT+F2 or by clicking the To-Do Bar submenu on the View menu (shown in 
the picture).  

 

 

Tip   Here's a quick way to make more room for other windows in Outlook (like the Reading Pane): Minimize 
the To-Do Bar by clicking the Minimize the To-Do Bar arrow next to its title. 

Name your color: Organize with colored categories 

Let’s say that you want to make certain people always 
show up easily in your inbox (such as emails from your 
administrator).  You can assign colors to different subject, 
contacts, etc.  Additionally, you can assign multiple colors 
to the same message. 

You create each category name and choose the color 
that's associated with it. Then, you can assign that 
category to incoming and existing messages. One way to 
assign a color category to a message is to right-click in the 
Categories column and use the shortcut menu, as we've 
shown in the picture. 

Once you've assigned a category to a message, you can quickly scan your Inbox and find the message just by 
looking for its colored tag. 

Tip   Unless you're adapting an existing system that's already working for you, it's probably best to stick to just 
a few categories. Keeping the system simple will make it easier to use. 

At first, Outlook categories have unspecific names: Red Category, Orange Category, and so on. Naturally, 
categories will have the most meaning for you if you give them names that are specific to the type of work you 
do. 

The first time you use one of the default categories, such as the Purple Category, Outlook will prompt you to 
rename it. You can type a new name for the category in the Name box, as we've shown in the picture. 



August 25, 2008 [EMAIL ETIQUETTE AND TIPS FOR IMPROVING EFFICIENCY] 

 

 

7 

Having trouble thinking of category names? It may help if you first think about what you have a hard time 
finding when you look through your e-mail. If you're new to categories, you may want to start with simple, 
basic groups such as Business and Personal. 

Arrange your email by color 

Click the Arranged By shortcut menu (under 
the Search box) and then click Categories. In 
the picture, we've switched from arranging 
messages by date to arranging them by their 
categories: Blue Yonder Airlines, Coho Winery, 
and Contoso. 

 
 
 

Categories and rules, a great combination 

Let’s say you want all emails from a certain person to stand out, you can 
create a rule that assigns a color to the email as it comes in.  Just follow 
these steps 

1. First, assign a color to a person (see above) 

2.  Select “Tools” and “Rules and Alerts” 

3. Select “New Rule” 

4. Start from a blank rule, and select “check messages when they 
arrive” 

 

 

5. Select “from people or distribution list” 

 

6. Down in the “Step 2” box, click on the blue underlined message “people or distribution list” 

 
 
 

7. The Global Address list box will pop up and you can search for the name (or names) that you would like 
to have automatically categorized.  After you select them, click “OK” 

1 

3 

4 

5 
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Now the “Step 2” box should look like this: 

 

  

8. Click “Next” and select the “assign it to the category 
category” 

 

9. In the “Step 2” box, click on the blue underlined word: 
“category” and then select the category.  Click “Next”. 

 

10. This next step is if you need exceptions.  You shouldn’t 
need any, but this would be good if you were creating the rule 
based on a distribution list and didn’t want to include some people 

on that list… Click “Next”. 

 

11. Finally, name your rule, and then make sure both check boxes 
are selected and click “Finish” 

Don’t Delete… Archive Instead 

If you keep every email sent, your email box will fill up and stop sending.   
Sometimes though, you want to find an email from a previous year.    The 
search feature in Outlook is extremely good and will search your archived 
mail as well.  AutoArchive is on by default. You'll know it's working if you're periodically prompted with the 

"Would you like to AutoArchive…" message 

 If the Run AutoArchive every check box is selected, 
AutoArchive is on. (And if you don't like AutoArchive, you can 
turn it off from here by clearing the check box.)  

You do it by clicking Options on the Tools menu, clicking the 
Other tab, and then clicking the AutoArchive button 

The number of days indicates the frequency with which 
AutoArchive will run.   Make sure it archives to the “U” drive 
so that you can access your archived email from around the 
district. 
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